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I was amazed when Excel 2007 upped the row limit from 65,536 rows 

to 1.1 million rows. (Excel 2010, when combined with the PowerPivot 

add-in, can now sort, filter, and pivot 100 million rows!) Combine the 1 

million rows with new charting, data visualizations, intelligent business 

diagrams, the SUMIFS function, Remove Duplicates, Page Layout view, 

table functionality, and Excel 2007 should have been the best-selling 

version of all time. 

But IT departments everywhere delayed rolling out Office 2007 because 

the familiar menus and toolbars had been replaced by the ribbon. 

Suddenly, all the commands that people knew where to locate were 

shuffled around. This was fine for people new to Excel, but it meant 

some time to get up the learning curve for the 500 million people already 

using Excel. 

It was fun to complain about why Microsoft would remove the familiar 

menus and toolbars from Excel 2007. We could mock them for replacing 

the all-important File menu with an icon so that no one could figure out 

how to print a document. But the Excel versions march on, and the rib-

bon is here to stay. When you get right down to it, there are really two 

things to learn about the ribbon: (1) Pivot Tables are on the Insert tab 

instead of the Data tab. (2) Most of the stuff that you think would be on 

the Insert tab  is under the Insert drop-down on the Home tab. Master 

those two facts and the rest of the stuff is in a logical place. Besides, 

Microsoft replaced the mysterious wordless symbol on the File menu 

with the word “File” and dramatically improved that File menu into a 

full-screen Backstage view (see Chapter 1). You can now customize the 

ribbon so that you can move the PivotTable drop-down back to the Data 

tab where it belongs (for customizing the ribbon, see Chapter 3). And 

Microsoft added even more new features to Excel 2010. 

    INTRODUCTION  



Introduction2

     New in Excel 2010  
Every new Office version has a set of themes, and the new features are grouped around those 

themes. For Excel 2010, the themes were to improve Excel’s reputation in the scientific community 

and to make Excel the premier tool for Business Intelligence. As a former data analyst, I love the 

new features for analyzing data. I also remember that while I loved wrangling large data sets into 

meaningful analyses, I never wanted to spend the time to make those meaningful analyses look 

“pretty.” Excel 2010 offers new graphics improvements that make it easy to add some visual inter-

est to your  numbers. 

  Improvements in Business Intelligence  
 • PowerPivot Add-In— You can now sort, filter, and pivot data sets that are beyond 1 million rows. 

The PowerPivot tool allows you to mash up 100 million rows of data from Excel, text files, RSS 

Feeds, SQL Server, Oracle, and more. A new DAX expression language offers time intelligence 

functions that enable you to compare fiscal year-to-date sales with the parallel period from a year 

ago. See Chapter 24 for more about PowerPivot. 

 • Pivot Table Slicers— Filtering data in pivot tables becomes visual with graphical filters known 

as Slicers. In previous versions of Excel, the filter drop-downs offered the capability to choose 

Multiple Items, but no one reading the report could tell what was included or not included. These 

new graphical filters show what is in the summary report and invite people to do ad-hoc analy-

ses by choosing new options from the slicers. See Chapter 25 for details on slicers. 

 • Asymmetric Pivot Tables— Do you need to show last year’s actuals versus this year’s budget? 

That was hard to do in previous versions of Excel, but the Named Sets command for pivot tables 

created from OLAP data make it easy in Excel 2010. Don’t have OLAP? Run your Excel data 

through PowerPivot to enable Named Sets. See Chapter 24.

 • Percentage of Parent Item in Pivot Tables— New calculations in the Show Values As drop-down 

allow for calculations such as Percentage of Parent row, Rank, and more. 

 • AGGREGATE function— Whereas Excel 2007 added the plural SUMIFS function, the killer func-

tion in Excel 2010 is AGGREGATE. This function is like the SUBTOTAL function on steroids. You 

have 19 calculation options instead of the 11 in SUBTOTAL, plus the capability to ignore hidden 

rows, filtered rows, or error cells. Read about Aggregate in Chapter 11.

  Presentation Improvements  
 • Tiny Charting with Sparklines— Edward Tufte published his first descriptions of the intense, 

tiny, word-sized charts in a book in 2006. Microsoft incorporated three types of sparklines in 

Excel 2010. Chapter 33 will describe how to leverage sparklines. Sparklines join the Excel 2007 

data visualizations. In that area, the old Data Bars feature gets a makeover with new options. See 

Chapter 31.
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 • New SmartArt Layouts— Fifty new business diagram layouts bring the total to more than 130 

types of business diagrams that you can create with the SmartArt tools. Learn about SmartArt in 

Chapter 34.

 • Better Picture Tools and Background Removal— If you need to dress up a report with a photo-

graph, improved picture tools help to correct the picture. A fairly cool background removal tool 

will have you creating odd-shaped picture elements. See Chapter 35. Also in this chapter, learn 

about a new screen clipping tool that allows you to paste a picture of a section of any screenshot 

into your worksheet. 

  Excel Interface Improvements  
 • Paste Options Flyout— If you study the Undo command, can you guess which operation immedi-

ately precedes Undo most often? It is Paste or one of the Paste variants. The new Paste Options 

flyout will help you paste data with/without borders, formulas, links, column widths, and so on. 

Ctrl+C, Ctrl+V, Ctrl, V is becoming my favorite key sequence. See Chapter 4.

 • File Menu Becomes Backstage View— Most ribbon tabs contain commands that you use while 

working in your document. The File menu contains commands that you do to the entire docu-

ment when you are done with your document. The team at Microsoft figured that these com-

mands don’t require you to see the document, so all the screen real estate is taken up with a 

new full-screen File menu. Read about Backstage view in Chapter 1.

 • Ribbon Customizations— This should not even be noted in the book because it has been possible 

to customize ribbons and toolbars for more than a decade. However, Excel 2007 offered no way 

in the Excel interface to customize the ribbon. Chapter 3 shows you how to customize the ribbon 

in Excel 2010. 

  Improvements for the Science Community  
 • Improved Function Accuracy— Various academic papers had attacked the accuracy of some of 

Excel’s statistical, financial, and math functions. Microsoft hired two outside math consultancy 

firms to rewrite the algorithms for a number of functions and then hired a third firm to vali-

date which algorithm was the best for each function. See Chapter 10 for a discussion of these 

improvements.

 • Consistency in Function Names— The statistical function set had been a confusing jumble of 

functions. For every distribution, you always had to check Help to see whether the particular 

function was a cumulative function, left-tailed, right-tailed, and so on. You will begin to see many 

new functions that include the dot in their name. Those dots will lead to an easier-to-understand 

description of the function. For statistical distribution functions, a name like < distribution>.DIST

will be the left-tailed cumulative distribution when the cumulative parameter is TRUE and the 

probability density function when the cumulative parameter is FALSE. If you need a right-tailed 
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distribution, look for < distribution>.DIST.RT. For two-tailed, < distribution>.DIST.2T. The inverse 

functions will be < distribution>.INV. Functions based on a sample will be < function>.S and func-

tions based on a population will be < function>.P. Excel still supports the old names, but new 

formulas can be created with VAR.S and VAR.P instead of the old VAR and VARS. See Chapters

10 and  14 for a description of these new function names. 

 • Equation Editor— You can now insert a variety of equations into a text box in Excel. The 

Equation tools support Radicals, Integrals, Matrices, brackets, functions, and symbols. You can 

convert the equation into a linear view for editing and then press a button to turn it back into a 

2D equation. 

  Upgrading from Excel 2003 or Earlier  
A large percentage of the people upgrading to Excel 2010 are people who skipped over Excel 2007. 

This book assumes that things that were new in Excel 2007 are still new to over half of the readers. 

If you are upgrading from Excel 2003, watch for these new features: 

 • Massive Grid— 1.1 million rows and 16,000 columns. That’s 17 billion cells, just on Sheet 1. Read 

about the big grid in Chapter 7.

 • Data Visualizations— Icon sets, color scales, and in-cell bar charts are found on the Conditional 

Formatting drop-down of the Home tab. See Chapter 31 for more on these tools. 

 • Better Looking Charts— The Excel 2007 charting engine is new. The charts look better. The 

charting interface has improvements, but it is harder to do some things than in Excel 2003. Read 

about charts in Chapter 32.

 • Remove Duplicates— You can remove duplicates with a couple of clicks using the new command 

on the Data tab. 

 • Page Layout View— Edit headers and footers in place using the new Page Layout view. 

  How This Book Is Organized  
The book is organized into the following parts: 

 • Part I, “Mastering the New User Interface”— This first part of the book shows you the ribbon, 

Backstage View, Mini Toolbar, Quick Access Toolbar, and more. 

 • Part II, “Calculating with Excel”— This part covers what Excel does best, from formulas to func-

tions to linking. 

 • Part III, “Business Intelligence”— Sorting, Filtering, Subtotals, Pivot Tables. These are the tools 

of the Excel data analyst. Learn about these tools and the new PowerPivot add-in in Part III. The 

chapter on VBA macros is also in this part. 

 • Part IV, “Visual Presentation”— This part covers charting, SmartArt, data visualizations, and 

picture tools. After you get done analyzing the data, a few features from this part will make your 

reports look good. 
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 • Part V, “Sharing Information”— This part discusses printing and sharing your Excel workbooks 

by creating PDFs, or publishing to the Web. 

  Conventions Used in This Book  
The special conventions used throughout this book are designed to help you get the most from the 

book as well as from Excel 2010. 

  Text Conventions  
Different typefaces are used to convey various things throughout the book. They include those 

shown in Table I.1.

  Table I.1   Typeface Conventions   

  Typeface     Description   

Monospace Screen messages appear in monospace.

Italic New terminology appears in italic.

Bold References to text you should type appear in bold.

Ribbon names, dialog box names, and dialog box elements are capitalized in this book (for example, 

Add Formatting Rule dialog, Home tab). 

In this book, key combinations are represented with a plus sign. If the action you need to take is to 

press the Ctrl key and the T key simultaneously, the text tells you to press Ctrl+T. 

There were not many changes from Excel 97 to Excel 2000 to Excel 2002 to Excel 2003. Most people 

upgrading to Excel 2010 will be coming from one of these versions of Excel. I will collectively refer 

to these versions as “legacy versions of Excel.” 

  Special Elements  
Throughout this book, you’ll find tips, notes, cautions, cross-

references, case studies, Excel in Practice boxes, sidebars, and 

Troubleshooting Tip boxes. These elements provide a variety of 

information, ranging from warnings you shouldn’t miss to ancil-

lary information that will enrich your Excel experience but isn’t 

required reading.   
Cross References 

  See Chapter 99 for more information.    

 note 
 Notes contain extra information 
or alternative techniques for per-
forming tasks.  

 tip 
 Tips point out special features, 
quirks, or software tricks that 
will help you increase your pro-
ductivity with Excel 2007.  
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    The author has more than 1,200 Excel podcast episodes 

available. Certain topics in the book will refer you to a 

video demo in the Excel In Depth channel at YouTube.       

 caution 
Cautions call out potential 

gotchas.

  Case Study: Other Elements  

 Sections such as Case Study, Excel in Practice, and Troubleshooting Tips are set off in boxes 
such as this one:  

    •   Case studies walk you through the steps to complete a task.   

   •   Excel in Practice boxes walk through real-life problems in Excel.   

   •   Troubleshooting Tips boxes walk through steps to avoid certain problems or how to react 
when certain problems occur.     

  Sidebars  

 Historical glimpses and other information that is not critical to your understanding appear as 
sidebars. I imagine that if the Cliff Claven character from  Cheers  knew a lot about Excel, these 
would be the kinds of things he would write.           
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 KEYBOARD SHORTCUTS  
If you do a lot of typing, being able to access commands from the keyboard is 

faster than moving your hand to the mouse. Excel 2010 introduces new keyboard 

accelerators accessed using the Alt key. In addition, many of the old Alt 

keyboard shortcuts still work and all the old Ctrl shortcut keys are still func-

tional. For instance, Ctrl+C still copies a selection, Ctrl+X cuts a selection, and 

Ctrl+V pastes a selection. 

This chapter points out which of the old keyboard shortcuts still work, shows 

you some new shortcuts, and introduces you to the new keyboard accelerators. 

     Using New Keyboard Accelerators  
The goal of the new Excel 2010 keyboard accelerators is to allow you to access 

every command by using only the keyboard. In legacy versions of Excel, many 

popular commands had keyboard accelerators, but other commands did not. 

Excel 2010 tries to ensure that every command can be invoked from the key-

board.

To access the new accelerators, press and release the Alt key. Notice that Excel 

places a ToolTip above each command, with an associated accelerator key. 

Note that an arcane command exists in the Excel Options dialog that can cause 

the new keyboard accelerators not to work for you. It is possible that you turned 

on this setting in Excel 1995 and each successive upgrade of Excel has inherited 

the setting. You should check the setting before proceeding. To do so, select 

the Office icon and then select Excel Options. In the Advanced category, scroll 

to near the bottom for Lotus Compatibility. If Transition Navigation Keys is 

selected, then the slash character shown in the Microsoft Office Menu Key will 

be used instead of Alt to  invoke shortcuts. If you prefer using the Alt key, you 

should clear the Transition Navigation Keys check box. Keep in mind that if you 

prefer using the slash key, you must use / in place of Alt with new keyboard 

accelerators.
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Tiny letter ToolTips appear over each tab of the ribbon. In addition, number ToolTips appear over 

each icon in the Quick Access toolbar. Figure 5.1 shows the ToolTips. 

Keyboard accelerators
for Ribbon tabs

Keyboard
accelerators
for QAT icons

 Figure 5.1 
 Type the 
letters in 
the ToolTips 
along the 
top to open 
various tabs. 
Type the 
numbers in 
the numeric 
keytips to 
access the 
Quick Access 
Toolbar.        

It is possible to memorize the keytips for the ribbon tabs. 

Pressing Alt+F always accesses the File menu in all Office 2010 applications. 

Alt+H always accesses the Home tab in all Office 2010 applications. The accelerator definitions for 

each tab remain constant even if new ribbon tabs are displayed. When you activate a pivot table, 

the original keytip letters (F, H, N, P, M, A, R, W, L, and X) remain, and two new keytips appear for 

the two new tabs: JT for PivotTable Tools Options and JY for PivotTable Tools Design (see 

Figure 5.2).

Contextual Tab Shortcuts  Figure 5.2 
 New ribbon tabs get new letters, making sure the old let-
ters remain constant.        
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Unfortunately, the keytips for the Quick Access toolbar change every time you add new buttons or 

rearrange buttons on the Quick Access toolbar. If you want to memorize those keytips, you need to 

make sure you do not add a new Quick Access toolbar icon at the beginning of the list. 

  Selecting Icons on the Ribbon  
After you press the Alt key, you can press one of the keytip letters to bring up the appropriate tab. 

You now see that every icon on the ribbon has a keytip. 

When you choose a ribbon tab, the keytips on the Quick Access toolbar disappear, so Microsoft is 

free to use the letters A through Z and the numbers 0 through 9. 

On very busy Ribbon tabs, some commands require two keystrokes: for example, A+C for Align 

Center in the Alignments Group of the Home tab, as shown in Figure 5.3. Note that after you press 

Alt to display the accelerators in the ToolTips, you do not have to continue holding down the 

Alt key. 

Some shortcut keys seem to make sense: AT for Align Top, AM for Align Middle, AB for Align 

Bottom, AL for Align Left, W for Wrap Text, and M for Merge. Other shortcut keys seem to be 

assigned at random. Some take a little pondering: FA for the dialog launcher in Figure 5.3 makes 

sense in that it opens the legacy Format dialog and moves to the Alignment tab. Others have a 

historical precedent. In Excel 2003, F was used for File so O was used for F ormat. Similarly, in the 

Home tab, O now opens the Format drop-down, although since Microsoft  no longer underlines the 

accelerator key in the menu name, O will never make sense to someone new to Excel. There might 

be some arcane, logical reason why 5 and 6 are used for increase and decrease indent, but it is 

unknown by most people.  

 Figure 5.3 
 After pressing the letter to switch to the ribbon, type the letter 
or letters to invoke a particular command.        

  Selecting Options from a Gallery  
Figure 5.4 shows the results of pressing Alt+H+T, which is the equivalent of selecting Home, 

Format Table. This opens the gallery of possible table styles. As you can see in Figure 5.4, you can 

invoke the New Table Style and New Pivot Style commands at the bottom of the gallery by pressing 

N and P, respectively. However, there are no letters on the table style choices in the gallery. 

To select a table style using the keyboard, use the arrow keys to move through the gallery. Because 

this gallery is two-dimensional, you can use the up arrow, down arrow, right arrow, left arrow, Page 

Down, Page Up, Home, and End keys to navigate through the gallery. When you have the desired 

table style highlighted, press the Enter key to select it.  
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  Navigating Within Drop-Down Lists  
If you press Alt+H+F+S, which is the equivalent of selecting Home, Font Size, the font size in the 

drop-down is selected. You can either type a font size and press Enter or press the down-arrow 

key to open the drop-down list. You can then use the down arrow, up arrow, Page Down, Page Up, 

Home, and End keys to navigate to a choice in the list. When you have the desired item highlighted, 

press Enter to select that item. 

  Backing Up One Level Through a Menu  
Suppose that you press Alt+H to access the Home tab and then realize you are in the wrong tab. 

You can press the Esc key to move back to display the ToolTips for the main menu choices. 

If you want to clear the ToolTips completely, press Alt again. 

  Dealing with Keyboard Accelerator Confusion  
If you want to select something on the Home tab in Figure 5.2,

you may be frustrated because you can see the menu choices, but 

there are no ToolTips for most commands. For icons in the top of 

the ribbon, it appears that the main keytips apply to the menu 

items. For example, you may think that the H keytip applies to 

Cut. Even though you are already on the Home tab, you need to 

press the H key to force Excel to show the ToolTips for the indi-

vidual menu items on the Home tab. 

  Selecting from Legacy Dialog Boxes   
Some commands lead to legacy dialog boxes like the ones in 

previous editions of Excel. These dialog boxes do not display the 

Excel 2010 keytips. However, most of the dialog boxes do use 

the convention of having one letter of each command underlined, 

which is called a hotkey in Microsoft parlance. In this case, you 

can press the underlined letter to select the command. 

 Figure 5.4 
 After opening a gallery, you use the arrow keys to navigate 
through the gallery and press Enter to select a style.        

 note 
 If you find the accelerator 
ToolTips to be confusing and 
unwieldy, you need to attack 
them one at a time. Find a task 
that you use regularly, such 
as sorting the current data set 
ascending by the selected col-
umn. Press the Alt key. Press 
A for the Data tab. Notice that 
A sorts ascending and D sorts 
descending. These should be 
easy enough to remember; 
Alt+A+A for sort ascending, and 
Alt+A+D for sort descending.  
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For example, press Alt+H+V+S instead of selecting Home, Paste, Paste Special. You are then pre-

sented with the Paste Special dialog box, as shown in Figure 5.5. To select Values and Transpose in 

this dialog, press V for Values and E for Transpose, because those are the letters underlined in the 

dialog. You can then press Enter instead of clicking the default OK button. 

 Figure 5.5 
 In a legacy dialog box, type the underlined letters to select 
options.     

To watch a video of Legacy Dialog boxes, search for Excel In Depth 5 at YouTube.

  Using the Shortcut Keys  
Excel 2010 automatically recognizes all the Ctrl shortcut keys that were used in legacy versions of 

Excel. In fact, many of these keys are consistent across all Windows applications. Table 5.1 lists the 

common Windows Ctrl shortcut keys. 

  Table 5.1   Windows Shortcut Keys   

  Key Combination     Action   

Ctrl+C Copy.

Ctrl+X Cut.

Ctrl+V Paste.

Ctrl+Z Undo.

Ctrl+Y Redo.

Ctrl+A Select all .

Ctrl+S Save.

Ctrl+O Open.
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  Key Combination     Action   

Ctrl+W or Ctrl+F4 Close workbook .

Ctrl+N New workbook. 

Ctrl+P Print.

Ctrl+B Bold.

Ctrl+U Underline.

Ctrl+I Italic.

Ctrl+F Find.

Table 5.2 illustrates the shortcut keys that you use to navigate. 

  Table 5.2   Shortcut Keys for Navigation   

  Shortcut Key     Action   

Ctrl+Home Move to Cell A1. 

Ctrl+End Move to last cell in the used range of the worksheet. 

Ctrl+Page Up Move to previous worksheet. 

Ctrl+Page Down Move to next worksheet. 

Shift+F11 New Worksheet. 

Alt+Tab Switch to next program .

Alt+Shift+Tab Switch to previous program. 

Ctrl+Esc Display Windows Start menu. 

Ctrl+F5 Restore window size of current workbook. 

F6 Switch to next pane in a window that has been split. 

Ctrl+F6 When more than one workbook is open, switch to the next open 
workbook window. 

Ctrl+Shift+F6 Switch to the previous workbook window. 

Ctrl+F9 Minimize the window .

Ctrl+F10 Maximize the window. 

Ctrl+arrow key Move to edge of current region. 

Home Move to beginning of row. 
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  Shortcut Key     Action   

Ctrl+Backspace Scroll to display the active cell .

F5 Display the GoTo dialog .

Shift+F5 Display the Find dialog .

Shift+F4 Find next. 

Ctrl+. (period) Move to next corner of selected range. 

Table 5.3 shows the shortcut keys you use to select data and cells. 

  Table 5.3   Shortcut Keys for Selecting Data and Cells   

  Shortcut Key     Action   

Ctrl+spacebar If used outside a table, select entire column. If used 
inside a table, toggle between selecting the data, data 
and headers, and the entire column. 

Shift+spacebar Select entire row. If inside a table, toggle between 
selecting the table row and the entire row. 

Shift+backspace With multiple cells selected, revert selection to only 
the active cell. 

Ctrl+Shift+* Select the current region. 

Ctrl+/ Select the array containing the active cell. 

Ctrl+Shift+O (letter O) Select all cells that contain comments. 

Ctrl+\ In a selected row, select the cells that do not match 
the value in the active cell. 

Ctrl+Shift+| In a selected column, select the cells that do not match 
the value in the active cell. 

Ctrl+[ (opening square bracket) Select all cells directly referenced by formulas in the 
selection.

Ctrl+Shift+{ (opening brace) Select all cells directly or indirectly referenced by for-
mulas in the selection. 

Ctrl+] (closing square bracket) Select cells that contain formulas that directly refer-
ence the active cell. 

Ctrl+Shift+} (closing brace) Select cells that contain formulas that directly or indi-
rectly reference the active cell. 

Alt+; (semicolon) Select the visible cells in the current selection. 
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Table 5.4 shows the shortcut keys you use to extend a selection. 

  Table 5.4   Shortcut Keys for Extending Selections   

  Shortcut Key     Action   

F8 Turn Extend mode on or off. In Extend mode, EXT appears 
in the status line and the arrow keys extend the selection. 

Shift+F8 Add another range of cells to the selection or use the arrow 
keys to move to the start of the range you want to add. Then 
press F8 and the arrow keys to select the next range. 

Shift+arrow key Extend the selection by one cell. 

Ctrl+Shift+arrow key Extend the selection to the last nonblank cell in the same 
column or row as the active cell. 

Shift+Home Extend the selection to the beginning of the row. 

Ctrl+Shift+Home Extend the selection to the beginning of the worksheet. 

Ctrl+Shift+End Extend the selection to the last used cell on the worksheet in 
the lower-right corner. 

Shift+Page Down Extend the selection down one screen. 

Shift+Page Up Extend the selection up one screen. 

End+Shift+arrow key Extend the selection to the last nonblank cell in the same 
column or row as the active cell. 

End+Shift+Home Extend the selection to the last used cell on the worksheet in 
the lower-right corner. 

End+Shift+Enter Extend the selection to the last cell in the current row. 

Scroll Lock+Shift+Home Extend the selection to the cell in the upper-left corner of the 
window.

Scroll Lock+Shift+End Extend the selection to the cell in the lower-right corner of 
the window. 

Table 5.5 shows the shortcut keys you use for entering, editing, formatting, and calculating data. 

  Table 5.5   Shortcut Keys for Data Entry, Formatting, and Calculating Data   

  Shortcut Key     Action   

Enter Complete a cell entry and select the next cell below. 

Alt+Enter Start a new line in the same cell. 
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  Shortcut Key     Action   

Ctrl+Enter Fill the selected cell range with the current entry. 

Shift+Enter Complete a cell entry and select the next cell above. 

Tab Complete a cell entry and select the next cell to the right. 

Shift+Tab Complete a cell entry and select the previous cell to the left. 

Esc Cancel a cell entry. 

Arrow keys Move one character up, down, left, or right. 

Home Move to the beginning of the line. 

F4 or Ctrl+Y Repeat the last action. 

Ctrl+Shift+F3 Create names from row and column labels. 

Ctrl+D Fill down. 

Ctrl+R Fill to the right. 

Ctrl+F3 Define a name. 

Ctrl+K Insert a hyperlink. 

Ctrl+; (semicolon) Enter the date. 

Ctrl+Shift+: (colon) Enter the time. 

Alt+down arrow Display a drop-down list of the values in the current column of 
a range. 

Ctrl+Z Undo the last action. 

= (equal sign) Start a formula. 

Backspace In the formula bar, delete one character to the left. 

Enter Complete a cell entry from the cell or formula bar. 

Ctrl+Shift+Enter Enter a formula as an array formula. 

Esc Cancel an entry in the cell or formula bar. 

Shift+F3 In a formula, display the Insert Function dialog box. 

Ctrl+A When the insertion point is to the right of a function name in a 
formula, display the Function Arguments dialog box. 

Ctrl+Shift+A When the insertion point is to the right of a function name in a 
formula, insert the argument names and parentheses. 

F3 Paste a defined name into a formula. 
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  Shortcut Key     Action   

Alt+= (equal sign) Insert an AutoSum formula with the  SUM  function. 

Ctrl+Shift+”
(quotation mark) 

Copy the value from the cell above the active cell into the cell or 
the formula bar. 

Ctrl+’ (apostrophe) Copy a formula from the cell above the active cell into the cell or 
the formula bar. 

Ctrl+` (backtick) Alternate between displaying cell values and displaying formu-
las.

F9 Calculate all worksheets in all open workbooks. When a portion 
of a formula is selected, calculate the selected portion and then 
press Enter or Ctrl+Shift+Enter (for array formulas) to replace 
the selected portion with the calculated value. 

Shift+F9 Calculate the active worksheet. 

Ctrl+Alt+F9 Calculate all worksheets in all open workbooks, regardless of 
whether they have changed since the last calculation. 

Ctrl+Alt+Shift+F9 Recheck dependent formulas and then calculate all cells in all 
open workbooks, including cells not marked as needing to be 
calculated.

F2 Edit the active cell and position the insertion point at the end of 
the cell contents. If in-cell editing is turned off, moves the inser-
tion point to the formula bar. 

Alt+Enter Start a new line in the same cell. 

Backspace Edit the active cell and then clear it or delete the preceding 
character in the active cell as you edit cell contents. 

Delete Delete the character to the right of the insertion point or delete 
the selection. 

Ctrl+Delete Delete text to the end of the line. 

F7 Display the Spelling dialog box. 

Shift+F2 Edit a cell comment. 

Enter Complete a cell entry and select the next cell below. 

Ctrl+Z Undo the last action. 

Ctrl+Shift+Z When the AutoCorrect smart tag is displayed, undo or redo the 
last automatic correction. 

Delete Clear the contents of the selected cells. 

Ctrl+- (hyphen) Delete the selected cells. 
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  Shortcut Key     Action   

Ctrl+Shift++ (plus 
sign)

Insert blank cells. 

Alt+’ (apostrophe) Display the Style dialog box. 

Ctrl+1 Display the Format Cells dialog box. 

Ctrl+Shift+~ Apply the General number format. 

Ctrl+Shift+$ Apply the Currency format with two decimal places (negative 
numbers in parentheses). 

Ctrl+Shift+% Apply the Percentage format with no decimal places. 

Ctrl+Shift+^ Apply the Exponential number format with two decimal places. 

Ctrl+Shift+# Apply the Date format with the day, month, and year. 

Ctrl+Shift+@ Apply the Time format with the hour and minute, and AM or 
PM.

Ctrl+Shift+! Apply the Number format with two decimal places, thousands 
separator, and minus sign (-) for negative values. 

Ctrl+B Apply or remove bold formatting. 

Ctrl+I Apply or remove italic formatting. 

Ctrl+U Apply or remove underline. 

Ctrl+5 Apply or remove strikethrough. 

Ctrl+9 Hide the selected rows. 

Ctrl+Shift+( (opening 
parenthesis)

Unhide any hidden rows within the selection. 

Ctrl+0 (zero) Hide the selected columns. 

Ctrl+Shift+) (closing 
parenthesis)

Unhide any hidden columns within the selection. 

Ctrl+Shift+& Apply the outline border to the selected cells. 

Ctrl+Shift+_ (under-
score)

Remove the outline border from the selected cells. 

There are shortcut keys specifically for using the Border tab in the Format Cells dialog. Press Ctrl+1 

to display the Format Cells dialog. Press Ctrl+PgDn until you arrive at the Border tab. Then you can 

use the shortcut keys shown in Table 5.6.
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  Table 5.6   Shortcut Keys for Borders   

  Shortcut Key     Action   

Alt+T Apply or remove the top border. 

Alt+B Apply or remove the bottom border. 

Alt+L Apply or remove the left border. 

Alt+R Apply or remove the right border. 

Alt+H If cells in multiple rows are selected, apply or remove the horizontal divider. 

Alt+V If cells in multiple columns are selected, apply or remove the vertical 
divider.

Alt+D Apply or remove the downward diagonal border. 

Alt+U Apply or remove the upward diagonal border. 

  Using Excel 2003 Keyboard Accelerators  
In legacy versions of Excel, most menu items included one underlined letter. In those versions, you 

could hold down the Alt key while pressing the underlined letter to invoke the menu item. In the 

Excel 2003 screen shown in Figure 5.6, you can display the Edit menu by pressing Alt+E, and you 

can select Edit, Fill, Justify by pressing Alt+E+I+J. 

 Figure 5.6 
 Pressing Alt+E+I+J performs Edit, Fill, Justify.        
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Instead of pressing Alt+E+I+J all at once, when the Edit menu is displayed, you can display the Fill 

flyout menu by pressing I. Then you can perform the Justify command by pressing J. 

If you are a power Excel user, you probably have a few of these commands memorized, such as 

Alt+E+I+J for Edit, Fill, Justify; Alt+E+S+V for Edit, Paste Special, Values; and Alt+D+L for Data 

Validation. If you have some of these commands memorized, when you hear that the menu in 

Excel 2010 is completely gone, you might be worried that you have to relearn all the shortcut keys. 

However, there is good news for the power Excel gurus who have favorite Alt shortcut keys burned 

into their minds—most of them will continue to work as they did in Excel 2003. 

If you were an intermediate Excel user who regularly used the Excel 2003 keyboard accelerators 

but had to look at the screen to use them, you should start using the new keyboard accelerators dis-

cussed at the beginning of this chapter. 

  Invoking an Excel 2003 Alt Shortcut  
In Excel 2003, the main menus were File, Edit, View, Insert, 

Format, Tools, Data, Window, and Help. The keyboard accelerator 

commands in Excel 2003 were Alt+F, Alt+E, Alt+V, Alt+I, Alt+O, 

Alt+T, Alt+D, Alt+W, and Alt+H.  
If you are moving from Excel 2003 to Excel 2010, you will have the 

best success when trying to access commands on the Edit, View, 

Insert, Format, Tools, and Data menus. None of the keyboard accel-

erators associated with Window or Help work in Excel 2010. Alt+H 

takes you to the Home tab instead of the few commands on the 

Help menu, and Alt+W takes you to the View tab. 

Some of the keyboard shortcuts associated with the File menu in 

Excel 2003 continue to work in Excel 2010. Pressing Alt+F opens 

the File menu. In Excel 2003, pressing Alt+F+O performs File, 

Open. It happens that O is the shortcut on the File menu for Open, 

so pressing Alt+F+O in Excel 2010 also performs File, Open. 

For the shortcut keys Alt+E, Alt+V, Alt+I, Alt+O, Alt+T, and Alt+D, 

Excel switches into Office 2003 Access Key mode. In this mode, a 

ToolTip appears over the ribbon, indicating which letters you have typed so far (see

Figure 5.7). When you have entered enough letters, the command is invoked. If you have forgotten 

the sequence, you can press Esc to exit the Excel 2003 Access Key mode.  

 tip 
 In Excel 2007, you had to pause 
briefly after typing the first 
letter in the legacy shortcut 
key sequence. For example, 
you pressed Alt+E, paused, 
then pressed S,V to Edit, Paste 
Special, Values. If you did not 
pause, the second letter was lost 
because Excel displayed the pop-
up Office Key Sequence window. 
This problem has been solved in 
Excel 2010. You no longer have 
to pause between the first and 
second letters  

 Figure 5.7 
 The Office 2003 access key ToolTip shows which keys you have 
used so far while entering a legacy shortcut.        
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  Determining Which Commands Work in Legacy Mode  
If you try a command that no longer works in Excel 2010, nothing happens. Several commands don’t 

make sense in the framework of Excel 2010, so they have been deprecated. 

Table 5.7 lists the legacy keyboard commands and shows which of them continue to work in 

Excel 2010. 

  Table 5.7   Excel Legacy Keyboard Commands   

  Works in Shortcut     Excel 2010?     Command   

Alt+F+N Yes File, New 

Alt+F+O Yes File, Open 

Alt+F+C Yes File, Close 

Alt+F+S Yes File, Save 

Alt+F+A Yes File, Save As 

Alt+F+G No File, Save as Web Page 

Alt+F+W No File, Save Workspace 

Alt+F+H No File, File Search 

Alt+F+M No File, Permission 

Alt+F+E No File, Check Out 

Alt+F+E No File, Check In 

Alt+F+R No File, Version History 

Alt+F+B No File, Web Page Preview 

Alt+F+U No File, Page Setup 

Alt+F+T+S No File, Print Area, Set Print Area 

Alt+F+T+C No File, Print Area, Clear Print Area 

Alt+F+V No File, Print Preview 

Alt+F+P Yes as Alt+F+P+P File, Print 

Alt+F+D+M No File, Send To, Mail Recipient 

Alt+F+D+S No File, Send To, Original Sender 

Alt+F+D+C No File, Send To, Mail Recipient (for Review) 

Alt+F+D+A No File, Send To, Mail Recipient (as Attachment) 
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  Works in Shortcut     Excel 2010?     Command   

Alt+F+D+R No File, Send To, Routing Recipient 

Alt+F+D+E No File, Send To, Exchange Folder 

Alt+F+D+O No File, Send To, Online Meeting Participant 

Alt+F+D+X No File, Send To, Recipient Using Internet Fax 
Ser vice 

Alt+F+I No File, Properties 

Alt+F+1 Yes File, 1 

Alt+F+2 Yes File, 2 

Alt+F+3 Yes File, 3 

Alt+F+4 Yes File, 4 

Alt+F+5 Yes File, 5 

Alt+F+6 Yes File, 6 

Alt+F+7 Yes File, 7 

Alt+F+8 Yes File, 8 

Alt+F+9 Yes File, 9 

Alt+F+T No File, Sign Out 

Alt+F+X Yes File, Exit 

Alt+E+U Yes Edit, Undo 

Alt+E+R Yes Edit, Repeat 

Alt+E+T Yes Edit, Cut 

Alt+E+C Yes Edit, Copy 

Alt+E+B Yes Edit, Office Clipboard 

Alt+E+P Yes Edit, Paste 

Alt+E+S Yes Edit, Paste Special 

Alt+E+H No Edit, Paste as Hyperlink 

Alt+E+I+D Yes Edit, Fill, Down 

Alt+E+I+R Yes Edit, Fill, Right 

Alt+E+I+U Yes Edit, Fill, Up 
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  Works in Shortcut     Excel 2010?     Command   

Alt+E+I+L Yes Edit, Fill, Left 

Alt+E+I+A Yes Edit, Fill, Across Worksheets 

Alt+E+I+S Yes Edit, Fill, Series 

Alt+E+I+J Yes Edit, Fill, Justify 

Alt+E+A+A Yes Edit, Clear, All 

Alt+E+A+F Yes Edit, Clear, Formats 

Alt+E+A+C Yes Edit, Clear, Contents 

Alt+E+A+M Yes Edit, Clear, Comments 

Alt+E+D Yes Edit, Delete 

Alt+E+L Yes Edit, Delete Sheet 

Alt+E+M Yes Edit, Move or Copy Sheet 

Alt+E+F Yes Edit, Find 

Alt+E+E Yes Edit, Replace 

Alt+E+G Yes Edit, Go To 

Alt+E+K Yes Edit, Links 

Alt+E+O No Edit, Object 

Alt+E+O+V No Edit, Object, Convert 

Alt+V+N Yes View, Normal 

Alt+V+P Yes View, Page Break Preview 

Alt+V+K No View, Task Pane 

Alt+V+T+C No View, Toolbars, Customize 

Alt+V+F Yes View, Formula Bar 

Alt+V+S No View, Status Bar 

Alt+V+H Yes View, Header and Footer 

Alt+V+C Yes View, Comments 

Alt+V+V Yes View, Custom Views 

Alt+V+U Yes View, Full Screen (Caution: Use the 
Maximize button to return.) 
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  Works in Shortcut     Excel 2010?     Command   

Alt+V+Z Yes View, Zoom 

Alt+I+E Yes Insert, Cells 

Alt+I+R Yes Insert, Rows 

Alt+I+C Yes Insert, Columns 

Alt+I+W Yes Insert, Worksheet 

Alt+I+H Yes Insert, Chart 

Alt+I+S Yes Insert, Symbol 

Alt+I+B Yes Insert, Page Break 

Alt+I+A Yes Insert, Reset All Page Breaks 

Alt+I+F Yes Insert, Function 

Alt+I+N+D Yes Insert, Name, Define 

Alt+I+N+P Yes Insert, Name, Paste 

Alt+I+N+C Yes Insert, Name, Create 

Alt+I+N+A Yes Insert, Name, Apply 

Alt+I+N+L Yes Insert, Name, Label 

Alt+I+M Yes Insert, Comment 

Alt+I+A Yes Insert, Ink Annotations 

Alt+I+P+C Yes Insert, Picture, Clip Art 

Alt+I+P+F Yes Insert, Picture, From File 

Alt+I+P+S Yes Insert, Picture, From Scanner or Camera 

Alt+I+P+D Yes Insert, Picture, Ink Drawing and Writing 

Alt+I+P+A No Insert, Picture, AutoShapes 

Alt+I+P+W No Insert, Picture, WordArt 

Alt+I+P+O No Insert, Picture, Organization Chart 

Alt+I+G No Insert, Diagram 

Alt+I+O Yes Insert, Object 

Alt+I+I Yes Insert, Hyperlink 

Alt+O+E Yes Format, Cells 
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  Works in Shortcut     Excel 2010?     Command   

Alt+O+R+E Yes Format, Row, Height 

Alt+O+R+A Yes Format, Row, AutoFit 

Alt+O+R+H Yes Format, Row, Hide 

Alt+O+R+U Yes Format, Row, Unhide 

Alt+O+C+W Yes Format, Column, Width 

Alt+O+C+A Yes Format, Column, AutoFit Selection 

Alt+O+C+H Yes Format, Column, Hide 

Alt+O+C+U Yes Format, Column, Unhide 

Alt+O+C+S Yes Format, Column, Standard Width 

Alt+O+H+R Yes Format, Sheet, Rename 

Alt+O+H+H Yes Format, Sheet, Hide 

Alt+O+H+U Yes Format, Sheet, Unhide 

Alt+O+H+B Yes Format, Sheet, Background 

Alt+O+H+T Yes Format, Sheet, Tab Color 

Alt+O+A No Format, AutoFormat 

Alt+O+D Yes Format, Conditional Formatting 

Alt+O+S Yes Format, Style 

Alt+T+S Yes Tools, Spelling 

Alt+T+R Yes Tools, Research 

Alt+T+K Yes Tools, Error Checking 

Alt+T+H+H No Tools, Speech, Speech Recognition 

Alt+T+H+T No Tools, Speech, Show Text to Speech Toolbar 

Alt+T+D Yes Tools, Shared Workspace 

Alt+T+B Yes Tools, Share Workbook 

Alt+T+T+H Yes Tools, Track Changes, Highlight Changes 

Alt+T+T+A Yes Tools, Track Changes, Accept or Reject 
Changes

Alt+T+W Yes Tools, Compare and Merge Workbooks 
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  Works in Shortcut     Excel 2010?     Command   

Alt+T+P+P Yes Tools, Protection, Protect Sheet 

Alt+T+P+A Yes Tools, Protection, Allow Users to Edit Ranges 

Alt+T+P+W Yes Tools, Protection, Protect Workbook 

Alt+T+P+S Yes Tools, Protection, Protect and Share 
Workbook

Alt+T+N+M Yes Tools, Online Collaboration, Meet Now 

Alt+T+N+S Yes Tools, Online Collaboration, Schedule 
Meeting

Alt+T+N+W Yes Tools, Online Collaboration, Web Discussions 

Alt+T+N+N Yes Tools, Online Collaboration, End Review 

Alt+T+G Yes Tools, Goal Seek 

Alt+T+E Yes Tools, Scenarios 

Alt+T+U+T Yes Tools, Formula Auditing, Trace Precedents 

Alt+T+U+D Yes Tools, Formula Auditing, Trace Dependents 

Alt+T+U+E Yes Tools, Formula Auditing, Trace Error 

Alt+T+U+A Yes Tools, Formula Auditing, Remove All Arrows 

Alt+T+U+F Yes Tools, Formula Auditing, Evaluate Formula 

Alt+T+U+W Yes Tools, Formula Auditing, Show Watch 
Window

Alt+T+U+M Yes Tools, Formula Auditing, Formula Auditing 
Mode

Alt+T+U+S No Tools, Formula Auditing, Show Formula 
Auditing Toolbar 

Alt+T+V Yes Tools, Solver 

Alt+T+M+M Yes Tools, Macro, Macros 

Alt+T+M+R Yes Tools, Macro, Record New Macro 

Alt+T+M+S Yes Tools, Macro, Security 

Alt+T+M+V Yes Tools, Macro, Visual Basic Editor 

Alt+T+M+E No Tools, Macro, Microsoft Script Editor 

Alt+T+I Yes Tools, Add-ins 
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  Works in Shortcut     Excel 2010?     Command   

Alt+T+C No Tools, COM Add-ins 

Alt+T+A Yes Tools, AutoCorrect Options 

Alt+T+C No Tools, Customize 

Alt+T+O No Tools, Options 

Alt+T+D No Tools, Data Analysis 

Alt+D+S Yes Data, Sort 

Alt+D+F+F Yes Data, Filter, AutoFilter 

Alt+D+F+S Yes Data, Filter, Show All 

Alt+D+F+A Yes Data, Filter, Advanced Filter 

Alt+D+O Yes Data, Form 

Alt+D+B Yes Data, Subtotals 

Alt+D+L Yes Data, Validation 

Alt+D+T Yes Data, Table 

Alt+D+E Yes Data, Text to Columns 

Alt+D+N Yes Data, Consolidate 

Alt+D+G+H Yes Data, Group and Outline, Hide Detail 

Alt+D+G+S Yes Data, Group and Outline, Show Detail 

Alt+D+G+G Yes Data, Group and Outline, Group 

Alt+D+G+U Yes Data, Group and Outline, Ungroup 

Alt+D+G+A Yes Data, Group and Outline, Auto Outline 

Alt+D+G+C Yes Data, Group and Outline, Clear Outline 

Alt+D+G+E Yes Data, Group and Outline, Settings 

Alt+D+P Yes Data, PivotTable and PivotChart Report 

Alt+D+D+D Yes Data, Import External Data, Import Data 

Alt+D+D+W Yes Data, Import External Data, New Web Query 

Alt+D+D+N Yes Data, Import External Data, New Database 
Query

Alt+D+D+E Yes Data, Import External Data,List 
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  Works in Shortcut     Excel 2010?     Command   

Alt+D+I+D No Data, List, Discard Changes and Refresh 

Alt+D+I+B No Data, List, Hide Border of Inactive Lists 

Alt+D+X+I Yes Data, XML, Import 

Alt+D+X+E Yes Data, XML, Export 

Alt+D+X+R Yes Data, XML, Refresh XML Data 

Alt+D+X+X Yes Data, XML, XML Source 

Alt+D+X+P Yes Data, XML, XML Map Properties 

Alt+D+X+Q Yes Data, XML, Edit Query 

Alt+D+X+A Yes Data, XML, XML Expansion Packs Edit 
Query

Alt+D+D+A Yes Data, Import External Data, Data Range 
Properties

Alt+D+D+M Yes Data, Import External Data, Parameters 

Alt+D+I+C Yes Data, List, Create List 

Alt+D+I+R Yes Data, List, Resize List 

Alt+D+I+T Yes Data, List, Total Row 

Alt+D+I+V Yes Data, List, Convert to Range 

Alt+D+I+P Yes Data, List, Publish List 

Alt+D+I+L No Data, List, View List on Server 

Alt+D+I+U No Data, List, Unlink List 

Alt+D+I+Y No Data, List, Synchronize 

Alt+D+R Yes Data, Refresh Data 

Alt+W+N No Window, New Window 

Alt+W+A No Window, Arrange 

Alt+W+B No Window, Compare Side by Side with 
filename

Alt+W+H No Window, Hide 

Alt+W+U No Window, Unhide 

Alt+W+S No Window, Split 
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  Works in Shortcut     Excel 2010?     Command   

Alt+W+F No Window, Freeze Panes 

Alt+W+1 No Window, 1 

Alt+W+2 No Window, 2 

Alt+W+3 No Window, 3 

Alt+W+4 No Window, 4 

Alt+W+5 No Window, 5 

Alt+W+6 No Window, 6 

Alt+W+7 No Window, 7 

Alt+W+8 No Window, 8 

Alt+W+9 No Window, 9 

Alt+W+M No Window, More Windows 

Alt+H+H No Help, Microsoft Excel Help 

Alt+H+O No Help, Show the Office Assistant 

Alt+H+M No Help, Microsoft Office Online 

Alt+H+C No Help, Contact Us 

Alt+H+L No Help, Lotus 1-2-3 Help 

Alt+H+K No Help, Check for Updates 

Alt+H+R No Help, Detect and Repair 

Alt+H+V No Help, Activate Product 

Alt+H+F No Help, Customer Feedback Options 

Alt+H+A No Help, About Microsoft Office Excel 

Some people liked using Alt+F+T+S in Excel 2003 for File, Print Area, Set Print Area. If you are one 

of those people, you will be unhappy to hear that your favorite shortcut key is not supported in 

Excel 2010. However, most of the powerful and common shortcut keys are still available, so there is 

a good chance that your knowledge of past shortcut keys will help when you upgrade to Excel 2010. 
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CHISQ.TEST function, 390, 463

CHOOSE function, 280, 303

CLEAN function, 196, 260-261

Clearing

freeze panes, 647

list of recent workbooks, 14

Clip art, 1036-1037

Clipboard group (Ribbon), 24,
23

Close command, 9

Close workbook shortcut key, 
70

Closing Backstage view, 9-10

cluster stack charts, 871, 872

Clustered charts, 957

CODE function, 196, 262-264

Color limits, 112

Color scales, 931-932

Colors

cells, 894-896

custom number formats, 887

gridlines, 98

themes, 903

Column charts, 956

COLUMN function, 280, 308,
318

Columns

banded columns, 663-665

pivot tables, 112

tables, 651-652

text-to-columns feature, 
1086-1088

widths, 53, 896-897

COLUMNS function, 280, 319

COMBIN function, 191, 221

Commands

alphabetical list of all 
commands, 36

Commands Not in the 
Ribbon option, 36

Easy-XL add-in, 1079

finding, 30-31

formatting, 875

hybrid commands, 24

In commands, 8

keyboard accelerators, 65

left navigation pane, 9

Out commands, 8, 9

Quick Access Toolbar, 32-
33, 34

utilities, 874

WYSIWYG interaction 
model, 7

Comments

in cells, 917-918

in formulas, 294-295

Comp time, 99

Comparing documents, 860-
861

Comparison operators, 284

COMPLEX function, 186, 506,
527

CONCATENATE function, 196,
257

Conditional formatting, 293-
294, 926, 946-950

Conditional formatting limits, 
112

Confidence testing, 476

CONFIDENCE.NORM function, 
390, 476

CONFIDENCE.T function, 390,
476

Connections

Access database, 588-589

data on a web page, 581-584

managing, 595-598
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ODBC, 589-595

OLE DB, 589-595

SQL Server, 589-595

text file, 584-588

two worksheets, 571-580

XML, 589-595

Contextual tabs (Ribbon), 27-
29

Contiguous references, 318

Conventions used in this book, 
5-6

CONVERT function, 186, 506,
549

Converting

file type of workbook, 21

PDF data to Excel data, 873

Converting case of text, 257

Copy icon, 24

Copy shortcut key, 70

Copying

formats, 919-923

formulas, 124, 138-140, 151-
153

Correcting special states of 
workbooks, 15-16

CORREL function, 390, 441

COS function, 504, 512

COSH function, 504, 518

COUNT function, 203-205

COUNTA function, 203-205

COUNTIF function, 191, 229-
233

CountIf.3D function, 874

COUNTIFS function, 165, 178

COUPDAYBS function, 186,
345, 375

COUPDAYS function, 186, 345,
375

COUPDAYSNC function, 186,
345, 376

COUPNCD function, 186, 345,
376

COUPNUM function, 186, 345,
376

COUPPCD function, 186, 345,
376

COVARARIANCE.P function, 
440

COVARARIANCE.S function, 
441

COVARIANCE.P function, 390

COVARIANCE.S function, 390

Creating workbooks 

blank workbooks, 18

from a template, 18

Cropping pictures, 1025-1027

Ctrl shortcut keys. See
Shortcut keys 

Cube functions, 166, 182

CUBEKPIMEMBER function, 
184

CUBEMEMBER function, 182

CUBEMEMBERPROPERTY
function, 182

CUBERANKEDMEMBER
function, 184

CUBESET function, 184

CUBESETCOUNT function, 184

CUBEVALUE function, 184

CUMIPMT function, 186, 343,
345, 356-357

CUMPRINC function, 186, 343,
345, 357-358

Currency, 882

Custom functions, 112, 166

Custom lists, 97

CustomizeRibbon add-in, 873

Customizing

charts, 962, 968

Quick Access Toolbar, 35-37

Ribbon, 3, 31, 32, 57, 63-64,
873

Cut icon, 23

Cut shortcut key, 70

Cutting formulas, 151-153

     D  
dashboards, 872

Data analysis utilities, 874

Data bars, 926-930

Data entry, changing cell 
pointer setting from Down to 
Right, 97

Data menu in Excel 2003 and 
earlier, 23

Data tab (Ribbon), 23

Data visualizations, 925

Database functions, 277, 278-
282

DATE function, 193

DATEDIF function, 193

Dates

formats, 233-239

formatting, 888-889

functions, 239-256

grouping, 98

math, 155-157

DATEVALUE function, 193

DAVERAGE function, 282

DAX calculations, 771, 776-787

DAY function, 193

DAYS360 function, 193

DB function, 345, 361

DCOUNT function, 282

DCOUNTA function, 282

DDB function, 345, 362-363

de Bruin, Ron (developer of 
RDBMerge add-in), 874

DEC2BIN function, 186, 506,
546

DEC2HEX function, 186, 506,
544

DEC2OCT function, 186, 506,
545
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Decimal places, controlling in 
custom number formats, 887

Decimal points, automatically 
inserting, 99

Default file location, 97

DEGREES function, 504, 508

Deleting commands from 
Quick Access Toolbar, 34

DELTA function, 186, 506, 564

Depreciation functions, 359-
360

DEVSQ function, 390, 420

DGET function, 282, 339-340

Dialog boxes (legacy), 68-69

Dialog launchers, 24-25

DigDB add-in, 874

Digital signatures, 864-865

DISC function, 186, 345, 378-
379

Dispersion, 418

DMAX function, 282

DMIN function, 282

Document Inspector, 8, 17-18

DOLLAR function, 196, 273

Dollar signs in formulas, 124,
129-132

DOLLARDE function, 186,
345,386-387

DOLLARDFR function, 345

DOLLARFR function, 186

dot plot charts, 871

Downloading Easy-XL add-in, 
1079-1080

DPRODUCT function, 282

Dragging a worksheet to a 
new location, 54-55

Drawing borders, 891-893

Drawing Tools tab (Ribbon), 28

Drop-down lists, 68

DSTDEV function, 282

DSTDEVP function, 282

DSUM function, 282, 335-339,
341

Duplicates, 692-696

DURATION function, 186, 345,
384-385

DVAR function, 282

DVARP function, 282

E  
E-mail, sending workbooks via 

e-mail, 20, 1066-1070

Easy-XL add-in 

cleansing data, 1091-1094

downloading, 1079-1080

fiscal years, 1095

functionality, 874, 1079,
1093-1094

macros, 1095

sorting columns left to right, 
1088

summarizing data, 1088-
1091

tabular data, 1080

text-to-columns feature, 
1086-1088

VLOOKUP function 
alternative, 1080-1085

EDATE function, 186, 193

Edit menu in Excel 2003 and 
earlier, 23

Editing workbooks, 16-17

EFFECT function, 186, 345,
358-359

End key, 113

Engineering functions, 506

Entering formulas 

by typing, 124, 125-126, 132-
133

the same formula in many 
cells, 135-138

with arrow-key method, 
133-134

with mouse method, 133

EOMONTH function, 186, 193

Equal sign in formulas, 125,
126

Equation Editor, 4, 857, 863

Equation Tools tab (Ribbon), 
28

ERF function, 186, 506, 566

ERFC function, 186, 506, 566

Error messages in formulas, 
147-149

ERROR.TYPE function, 186,
279, 291

EUROCONVERT function, 283

EVEN function, 191, 204

EXACT function, 196, 272

Excel 2003 

creating Excel 2010 file 
formats, 121-122

keyboard accelerators, 76, 78

opening Excel 2010 files, 
120-121

upgrading from, 4

Excel 2007 

delayed roll out of, 1

opening Excel 2010 files, 122

PowerPivot add-in, 790

Excel Options dialog. See
Options dialog 

Excel Web App 

Edit in Browser option, 1062-
1064

publishing workbooks, 1059-
1062

sharing workbooks, 1059-
1065

Executive dashboards, 872

Exit command, 9

EXP function, 191, 523

Expanding tables, 650-652
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EXPON.DIST function, 390, 473

Exporting Ribbon 
customizations, 63

Extending selections with 
shortcut keys, 72

External functions, 278-283

     F  
F.DIST function, 390

F.DIST.RT function, 390

F.INV function, 390

F.INV.RT function, 390

F.TEST function, 390, 472

FACT function, 191, 221-222

FACTDOUBLE function, 186,
191

Fading toolbars, 48

FALSE function, 278, 287

Fast Fourier Transforms 
(FFTs), 568-569

Fields in pivot tables, 112

File formats, 115-118

File menu 

Backstage view, 3, 7, 8, 9

Excel 2003 and earlier, 23

Excel 2007, 8

Keyboard accelerator, 66

File size, viewing, 14

File types, converting file type 
of workbook, 21

Files

default file location, 97

opening, 9

pushpins, 11

recent files, clearing the 
list, 14

recent files, number listed, 
11

recent files, one-click access, 
11-13

recent files, scrolling to, 11

Recent gallery, 9-10

Recent Places feature, 11

trusted locations, 98

Filtering

Advanced Filter command, 
691, 693

pivot tables, 731, 741-742,
743, 749, 750

records, 679-689

Financial functions, 343, 348

Find All, limit on number of 
items found, 112

FIND function, 196, 267

Find shortcut key, 70

FINDB function, 196

Finding

characters in a cell, 267

commands, 30-31

functions, 168-170

hidden content, 17-18

number of characters in a 
text cell, 266

FISHER function, 390, 443

FISHERINV function, 390, 443

FIXED function, 196, 273

FLOOR function, 191, 204

FLOOR.PRECISE function, 179,
204

Flow control in macros, 845-
849

Flyout menus, 25-26

Folders, 11

Font (default font), 913-915

Font size, 890-891

Font typeface, 890-891

Footers, 53, 54, 1046-1050

FORECAST function, 390, 430

Format menu in Excel 2003 
and earlier, 23

Format Painter icon, 23

Formatting

advanced formatting, 942-
948

cell styles, 875

characters (individual 
characters), 913-914

commands, 875

conditional formatting, 293-
294, 926, 946-950

dates, 888, 889

formulas, 154-155

pivot tables, 718-720, 729-
730, 950-951

readability, 875-876

styles, 901-902

table styles, 875

times, 888, 889

Formatting toolbar in Excel 
2003 and earlier, 23

Formula AutoComplete, 169

Formula bar, 39, 50-51

Formulas

3D formulas, 599-603

absolute referencing, 127-
128

array formulas, 112, 613-618

assigning to a name, 609-613

combining multiple formulas 
into one, 603-606

comments, 294-295

copying, 124, 138-140, 151,
153

cutting, 151, 153

dollar signs, 124, 129-132

entering, by typing, 124,
125-126, 132-133
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entering, the same formula 
in many cells, 135-138

entering, using mouse 
method, 133

entering, with arrow-key 
method, 133-134

equal sign, 125, 126

error messages, 147-149

evaluating part of, 163

fill handle double-click trick, 
141-142

formatting, 154-155

formula bar, 124, 125

joining text, 149, 151

maximum length of, 112

mixed referencing, 128-129

moving ToolTips, 164

names, 624-631, 635-641

Natural Language Formulas, 
652

nesting, 112

number of, 124

plus sign, 124

R1C1-style formulas, 838-840

relative referencing, 126-127

slow motion calculation, 162-
163, 861

tables, 652-654

troubleshooting, 157-163

Formulas tab (Ribbon), 23

Fractions, 883-884

Freeze panes, 646-649

FREQUENCY function, 390, 452

Frontline Systems, 166

Full calculations, 112

Functions

accuracy, 3, 166

algorithms, 166

applicability to various 
industries, 166

arguments, 112

AutoSum feature, 172-176,
199

built-in functions, 165

consistency in names, 3-4

cube functions, 166, 182

custom functions, 112, 166

database functions, 277,
278-282

date functions, 239, 256

depreciation functions, 359-
360

engineering functions, 506

errors, 167

external functions, 278-283

financial functions, 343, 348

finding, 168-170

Formula AutoComplete, 169

Formulas tab, 167-168

Function Wizard, 169-170

help, 170-172

information functions, 277,
278-279, 291

logarithm functions, 519, 526

logical functions, 277-278

lookup functions, 277, 278-
280

matrix functions, 505

periods, 166

renamed functions, 180-183

statistical functions, 165-166,
389-390

syntax, 167

time functions, 239, 256

trig functions, 504

FV function, 345, 352-353

FVSCHEDULE function, 186,
345,387-388

     G  
Galleries

browsing, 26-27

keyboard accelerators, 67-68

Gallery control (Ribbon), 26-27

GAMMA.DIST function, 390,
469

GAMMA.INV function, 390, 470

GAMMALN function, 390, 470

GCD function, 186, 191, 222-
223

GEOMEAN function, 390, 410

GESTEP function, 186, 506, 564

GETPIVOTDATA function, 280,
332-334

Go To dialog, 114

Goal Seek, 791, 802-807

Gray pushpins, 11

Green triangles, 99

Grid limits, 109-111

Gridlines

colors, 98

printing, 1054-1055

Grouping dates, 98

GROWTH function, 390, 435

     H  
HARMEAN function, 390, 411

Header & Foot tab (Ribbon), 28

Headers

tables, 645-646

worksheets, 53, 1046-1050

Headings, 1054-1055

Help

functions, 170-172

Options dialog, 90

Help gallery, 21-22

Help menu in Excel 2003 and 
earlier, 23
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HEX2BIN function, 186, 506,
549

HEX2DEC function, 186, 506,
545

HEX2OCT function, 186, 506,
549

Hidden content, 17-18

Hidden icons on Quick Access 
Toolbar, 37

Hiding

green triangles, 99

interface elements, 97-98

Ribbon tabs, 62

Highlight cells rules, 937, 942

HLOOKUP function, 280, 310

Home tab 

Keyboard accelerator, 66

Ribbon, 24-23

HOUR function, 193

HTML file format, 115-116

Hybrid commands, 24

hyperbolic trigonometry, 517

HYPERLINK function, 280, 329

HYPGEOM.DIST function, 390,
473

     I  
Icon sets, 932-935

IF function, 278-284, 287-288,
293

IFERROR function, 165, 177,
278, 289-290

IMABS function, 186, 506, 531

IMAGINARY function, 186, 506,
527

imaginary numbers, 526

IMARGUMENT function, 186,
506, 532

IMCONJUGATE function, 186,
506, 533

IMCOS function, 186, 506, 534

IMDIV function, 186, 506, 530

IMEXP function, 186, 506, 534

IMLN function, 186, 506, 534

IMLOG10 function, 186, 506,
534

IMLOG2 function, 186, 506, 534

IMPOWER function, 186, 506,
533

IMPRODUCT function, 186,
506, 530

IMREAL function, 186, 506, 527

IMSIN function, 186, 506, 534

IMSQRT function, 186, 506, 533

IMSUB function, 186, 506

IMSUM function, 186, 506, 529

In commands, 8

INDEX function, 280, 314, 320

INDIRECT function, 280, 326,
606-609

Inferential statistics, 445

INFO function, 279, 297-298

Info gallery, 14-15

Information functions, 277,
278-279, 291

Ink Tools tab (Ribbon), 28

Insert menu in Excel 2003 and 
earlier, 23

Insert tab (Ribbon), 23

Inserting

charts, 957

clip art, 1036-1037

pictures, 27, 1023-1024

screen clippings, 1035-1036

symbols in cells, 861-862

worksheet in the middle of a 
workbook, 55

Installing

Easy-XL add-in, 1079-1080

PowerPivot add-in, 756

INT function, 191, 204

Interacting with other Office 
applications, 1070, 1078

Interactive Ribbon guide, 31

INTERCEPT function, 390, 424

Interface elements 

Formula bar, 39, 50-51

hiding, 97-98

Live Preview, 39, 40

Mini toolbar, 39, 47-49

New Sheet icon, 39, 54-55

Paste Options gallery, 39,
41-47

Status bar, 39, 52, 99

turning on/off, 97-98

View control, 39, 52-54

Zoom slider, 39, 51

Internationalization, 91

Internet Fax, 20

INTRATE function, 186, 345,
377-378

IPMT function, 343, 345, 355-
356

IRR function, 343, 345, 368

IS functions, 291

ISBLANK function, 279, 291

ISERR function, 279, 291

ISERROR function, 279, 291

ISEVEN function, 186, 279, 291

ISLOGICAL function, 279, 291,
293

ISNA function, 279, 291

ISNONTEXT function, 279, 291

ISNUMBER function, 279, 291

ISO.CEILING function, 165

ISO.FLOOR function, 165

ISO.Weeknum function, 874

ISODD function, 186, 279, 291

ISPMT function, 345

ISREF function, 279, 294

ISTEXT function, 279, 291,
293-294
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Italic icon, 892

Italic shortcut key, 70

J  
J-Walk’s Power Utility Pack, 

874

JIS function, 196

JMT Utilities, 874

Joining text, 149-151, 257

Justifying text, 916

     K  
Keyboard accelerators. See

also Shortcut keys 

accessing, 65

Alt key, 65

backing up one level through 
a menu, 68

commands, 65

confusion with, 68

drop-down lists, 68

Excel 2003, 76, 78

File menu, 66

finding commands via, 30

galleries, 67-68

Home tab, 66

legacy dialog boxes, 68-69

memorizing, 66

old keyboard accelerators, 
30, 65

Quick Access Toolbar, 67

Ribbon, 66, 67

slash (/) key, 65

Transition Navigation Keys 
check box, 65

troubleshooting, 65

KURT function, 390, 443, 444-
445

Kurtosis, 443-445

     L  
Labels (charts), 872

LARGE function, 390, 403

LastRow function, 873

LCM function, 186, 191, 223

Learn Excel from MrExcel: 427 
Excel Mysteries Solved Web 
site, 857

LEFT function, 196, 264

Left navigation pane, 9

LEFTB function, 196

Legacy dialog boxes, 68-69

LEN function, 196, 266

LENB function, 196

Line charts, 956

LINEST function, 390, 424, 425

Lists, 97

Live Preview, 39, 40

LN function, 504, 523

LOG function, 504, 522

LOG10 function, 504, 522

Logarithm functions, 519, 526

LOGEST function, 390, 433

Logical functions, 277-278

LOGNORM.DIST function, 390,
468

LOGNORM.INV function, 390,
468

LOOKUP function, 280, 317

Lookup functions, 277, 278-280

Loops in macros, 843-842, 843,
844

LOWER function, 196, 257

     M  
Mail merge, 819, 827, 1074-

1077

Margins, 53, 1050-1052

Marimekko charts, 871

Mark as Final option, 16-17

MATCH function, 280, 312

Mathematical operators, 143-
144

Matrix functions, 505

MAX function, 390, 402

MAXA function, 390

MDETERM function, 505, 538

MDURATION function, 186,
345, 386

MEDIAN function, 390, 406

Memorizing keyboard 
accelerators, 66

memory limits, 112

Menus, backing up one level, 
68

Merging

cells, 897-899

workbooks, 874

Microsoft OneNote 2010, 1071

MID function, 196, 264

MIDB function, 196

MIN function, 390, 402

MINA function, 390

Mini toolbar, 39, 47-49

Minimizing Ribbon, 31-32

MINUTE function, 193

MINVERSE function, 505, 536

MIRR function, 345, 368-370

MMULT function, 505, 537

MOD function, 191, 224-225

MODE.MULT function, 178-179,
390

MODE.MULTL function, 406

MODE.SNGL function, 390, 406

Modifications to workbooks, 14

MONTH function, 193

MoreFunc.dll, 873-874

Mosaic charts, 871
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Moving

charts, 960-961, 978

pivot tables, 721

Quick Access Toolbar, 33

ToolTips, 164

MrExcel iTunes podcast, 869

MROUND function, 186, 191,
204

MULTINOMIAL function, 186,
191, 223-224

Multithreaded calculation, 
857-858

     N  
N function, 279, 294-295

NA function, 279, 296-297

Name box, 622

Names

absolute references, 633-634

assigning a formula to a 
name, 609, 613

cells, 619-621

duplicate names, 622-623

formulas, 624-631, 635-641

Name Manager interface, 
619, 631-633

values, 634-635

Natural Language Formulas, 
652

Navigating, 71, 113-114

NBText function, 873

Negative time, 99

NEGBINOM.DIST function, 390,
450

Nesting formulas, 112

NETWORKDAYS function, 186,
193

NETWORKDAYS.INTL function, 
165, 179, 189, 193

New features, 2-4

New Sheet icon, 39, 54-55

New workbook shortcut key, 
70

NOMINAL function, 186, 345,
359

NORM.DIST function, 390, 455

NORM.INV function, 390, 456

NORM.S.DIST function, 390,
457

NORM.S.INV function, 390, 458

Normal View, 52

NOT function, 278, 287-289

NOW function, 193

NPER function, 345, 352

NPV function, 345, 366-367

Numerical Algorithms Group, 
166

     O  
Object variables, 837

OCT2BIN function, 186, 506,
549

OCT2DEC function, 186, 506,
545

OCT2HEX function, 506, 549

ODD function, 191, 204

ODDFPRICE function, 186, 345,
380

ODDFYIELD function, 186, 345,
380

ODDLPRICE function, 186, 345,
380

ODDLYIELD function, 186, 345,
380

Office Online templates, 18-19

OFFSET function, 280, 322

OneNote 2010, 1071

Open command, 9

Open shortcut key, 70

Opening

Backstage view, 9

Excel 2010 files in Excel 
2002 or 2003, 120-121

Excel 2010 files in Excel 
2007, 122

files, 9

Options dialog, 87

same files every day, 859-
860

Operators

ampersand (&) operator, 257

comparison operators, 284

mathematical operators, 
143-144

Options command, 9

Options dialog 

Add-Ins settings, 89

Advanced settings, 89

AutoComplete feature, 101

AutoCorrect feature, 101

AutoRecover feature, 101

AutoRecover options, 91

Backstage view, 87, 88

Calculation feature, 101

categories, 88, 89-88

Circular Reference feature, 
101

Color feature, 101

Customize Ribbon settings, 
89, 90

Dates as Text feature, 101

Empty Cells in Formula 
feature, 101

Error Indicators feature, 101

ErrorChecking feature, 101

Errors Ignored feature, 101

Errors in Formulas feature, 
101

features and functionality, 9,
87, 90, 101

File Format feature, 101

Folder for Files feature, 101



How can we make this index more useful? Email us at indexes@quepublishing.com

Pictures 1107

Font feature, 101

Font Size feature, 101

Formula Style feature, 101

Formulas Inconsistent in 
Table feature, 101

Formulas settings, 89

Formulas—Omitted Cells 
feature, 101

Formulas—Rules
Inconsistent feature, 101

General settings, 89

GetPivotData feature, 101

help, 90

Help Language feature, 101

HPC Cluster feature, 101

ISO Dates feature, 101

Language settings, 89, 91

Languages feature, 101

Live Preview feature, 101

Mini Toolbar feature, 101

Name feature, 101

Numbers as Text feature, 
101

opening, 87

performance, 92-94

Proofing settings, 89

Protected Sheet with 
Unlocked Formulas feature, 
101

Quick Access Toolbar 
settings, 89

R1C1 Style feature, 101

Resources category, 88

Save settings, 89

ScreenTip Language feature, 
101

Screentips feature, 101

security, 94-97

Server feature, 101

settings, 87, 90

Skin feature, 101

Spelling feature, 101

Table with Invalid Data 
feature, 101

tabs, 87

ToolTips, 90

Trust Center settings, 89

updating your name, 97

View feature, 101

Worksheets feature, 101

Options dialog box, 9

OR function, 278, 286-287

Orientation of worksheets, 20,
1052

Out commands, 8, 9

     P  
Page Break Preview, 52

Page breaks, 1055-1057

Page Layout tab (Ribbon), 23

Page Layout View, 52-54, 1044-
1045

page numbers in cells, 873

PageNum function, 873

Paper size, 1052-1053

Partial calculations, 112

Paste icon, 24

Paste Options flyout, 3

Paste Options gallery, 39, 41-
47

Paste shortcut key, 70

Path to a workbook, 14

PC memory limits, 112

PDFs

Able2Extract add-in, 873

converting data in PDFs to 
Excel, 873

creating, 20, 21, 1066-1070

PEARSON function, 390, 437

Peltier, Jon (developer of PTS 
Chart Utilities add-ins), 871-
872

PERCENTILE function, 179

PERCENTILE.EXC function, 
390

PERCENTILE.INC function, 
390, 415

Percentiles, calculating, 179

PERCENTRANK function, 179

PERCENTRANK.EXC function, 
390

PERCENTRANK.INC function, 
390, 417

Performance, 92-94

Periods in functions, 166

Permissions, 17

PERMUT function, 390, 478

PHONETIC function, 196

PI function, 191, 220-221

Picture command, 27

Picture Tools Format tab 
(Ribbon), 27-28

Picture Tools tab (Ribbon), 28

Pictures

adjusting and correcting, 
1027-1029

arranging, 1032-1034

background removal, 28

borders, 1030

captions, 1034

cropping, 1025-1027

features and functionality, 
1023

headers, 1048

inserting, 27, 1023-1024

new features, 3

Picture Styles gallery, 1024-
1025

reducing file size, 1026

removing the background, 
1030-1032
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resizing, 1024-1025

selecting, 27-28

Selection Pane, 1034

Pie charts, 956, 976-977

Pivot Chart Tools tab (Ribbon), 
28

Pivot charts, 979, 981

Pivot Table Data Crunching 
(QUE), 730

Pivot tables 

Access queries, 1076-1078

asymmetric pivot tables, 2

blank cells, 720-721

calculations, 721-728

cells, inserting, 721

columns, 112

compact layout, 715-716

creating, 713-715

features and functionality, 
711-712

fields, 112

filtering, 742, 743, 749, 750

filters, 731-741

formatting, 718-720, 729-730,
950-951

limits, 721

manual calculation mode, 
720

moving, 721

percentage of parent item, 2

PivotTable Styles gallery, 
729-730

PowerPivot tables, 770-771

rearranging, 716-718

resources, 730

roll-ups, 721-728

slicers, 2, 731, 745-748

sorting, 750-752

tools, 721

PivotTable Tools tab (Ribbon), 
28

Plus sign in formulas, 124

PMT function, 343, 345, 348-
349

POISSON.DIST function, 390,
451

Power Excel program, 123

POWER function, 191, 227-228

PowerPivot add-in 

benefits, 2, 753-755

capabilities, 753

combination layouts, 787

DAX calculations, 771, 776-
777, 787

differences between pivot 
tables and PowerPivot 
pivot tables, 770-771

drawbacks, 756

Excel 2007, 790

Installing, 756

Microsoft SQL Server 
Analysis Services team, 
753

PowerPivot for the Excel 
Data Analyst (QUE), 787

refreshing, 789

relationships, 790

report formatting, 788-789

reports, 757-770

server version, 755

SQL Server data, 789

Undo feature, 756

VBA, 756

PowerPivot for the Excel Data 
Analyst (QUE), 730

PPMT function, 343, 345, 354-
355

PRICE function, 186, 345, 374-
376

PRICEDISC function, 186, 345,
381-382

PRICEMAT function, 186, 345,
380-382

Print area, 1052-1053

Print Preview, 18-19

Print Preview Tools tab 
(Ribbon), 28

Print shortcut key, 70

Print titles, 1053-1054

Printing

Backstage view, 18-20, 1039-
1044

gridlines, 1054-1055

orientation of documents, 20

overview of options, 1039

Print Preview, 18-19

Printing gallery, 18-20

Quick Print, 20, 1044

PROB function, 390, 475

PRODUCT function, 191, 226-
227

Product key, 21

Product version, 21

PROPER function, 196, 257

Protected view, 16-17

Protecting worksheets, 865-866

PTS Chart Utilities add-ins, 
871-872

Publish with Interactivity 
option, 1059

Publishing workbooks, 1059-
1062

Pushpins, 11

PV function, 345, 350-351

Pythagorean theorem, 508-509

     Q  
QAT feature, 101

QAT Location feature, 101

QUARTILE function, 179, 415

QUARTILE.EXC function, 390

QUARTILE.INC function, 390

Quartiles, calculating, 179
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Quick Access Toolbar 

as alternative to Ribbon, 32

commands, adding, 34

commands, removing, 34

commands, storing, 32-33

customizing, 35-37

drawbacks, 38

hidden icons, 37

keyboard accelerators, 67

macros, 37-38

moving, 33

QuickPrint, 20

rearranging icons, 37

Recent File List, 11-12

resetting, 37

ToolTips, 66

Quick Print, 20, 1044

QUOTIENT function, 186, 191,
225-226

     R  
R1C1-style formulas, 838-840

RADIANS function, 504, 508

RAND function, 191, 215-217

RANDBETWEEN function, 186,
191, 215-217

Ranges

borders, 894

justifying text, 916

macros, 844

navigating, 114

RANK function, 179, 412

RANK.AVG function, 390, 412

RANK.EQ function, 390, 412

RATE function, 345, 349-350

RDBMerge add-in, 874

Rearranging

icons on the Quick Access 
Toolbar, 37

pivot tables, 716-718

RECEIVED function, 186, 345,
376-377

Recent gallery, 9-10

Recent Places feature, 11

Recording macros, 817, 818-819

Records

duplicates, 692, 696

filtering, 679-689

Recovering unsaved 
workbooks, 13

Redo shortcut key, 70

References

absolute references, 633-634

contiguous references, 318

tables, 659-663

Refreshing PowerPivot add-in, 
789

REGISTER.ID function, 283

Regression, 421-423

Relationships in PowerPivot 
pivot tables, 790

Removing

commands from Quick 
Access Toolbar, 34

duplicates, 692, 696

page breaks, 1057

status bar, 99

Renamed functions, 180, 183

REPLACE function, 196, 270

REPLACEB function, 196

Reports, 757-770

REPT function, 196, 272

Resetting

Quick Access Toolbar, 37

Ribbon customizations, 63

Resizing

charts, 960-961

clip art, 1036

pictures, 1024-1025

tables, 651

windows, 29-30

Restrict Permission by People, 
17

Review tab (Ribbon), 23

Ribbon

Add-Ins tab, 28

adding tabs, 62

alternatives to, 32

Background Removal tab, 28

Caret icon, 31, 32

Chart Tools tab, 28

Clipboard group, 24, 23

Commands Not in the 
Ribbon option, 36

constant changes to, 27

contextual tabs, 27-29

customizing, 3, 31, 32, 57,
63-64, 873

Data tab, 23

delayed roll out of Excel 
2007, 1

dialog launchers, 24-25

Drawing Tools tab, 28

Equation Tools tab, 28

exporting customizations, 63

finding commands, 30-31

flyout menus, 25-26

Formulas tab, 23

gallery control, 26-27

Header & Foot tab, 28

hiding tabs, 62

Home tab, 24-23

Ink Tools tab, 28

Insert tab, 23

Interactive Ribbon guide, 31

keyboard accelerators, 66, 67

minimizing, 31-32

modifications, 57-61

Page Layout tab, 23
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Picture Tools Format tab, 
27-28

Picture Tools tab, 28

Pictures and Words mantra, 
23

Pivot Chart Tools tab, 28

PivotTable Tools tab, 28

Print Preview Tools tab, 28

resetting customizations, 63

Review tab, 23

showing tabs, 62

Slicer Tools tab, 28

SmartArt Tools tab, 29

Sparkline Tools tab, 29

Table Tools tab, 29

tip card, 31

View tab, 23

viewing entirety of, 29-30

what it replaces, 23

RibbonX: Customizing the 
Office 2007 Ribbon (Wiley), 
64

RIGHT function, 196, 264

RIGHTB function, 196

ROMAN function, 191, 217-219

Rotating text, 899-900

ROUND function, 191, 204

ROUNDDOWN function, 191,
204

ROUNDUP function, 191, 204

ROW function, 280, 318

Rows

banded rows, 663-665

heights, 896-897

number of, 109

tables, 649-650, 651

ROWS function, 280, 319

RSQ function, 390, 438

RTD function, 280, 332

Ruler, 53

     S  
Save & Send gallery, 20-21

Save As command, 9

Save command, 9

Save shortcut key, 70

Saving workbooks 

as PDF, 21

as XPS, 21

to SharePoint, 9

to Web, 9

Scaling options, 1053-1054

Scatter charts, 872, 956

Scenario Manager, 795-802

Schmid, Patrick (developer of 
CustomizeRibbon add-in), 
873

ScienceOps, 166

Scientific notation, 889

Screen

Backstage view, 7, 9

parts of, 9

Recent Places feature, 11

Screen clippings, 1035-1036

SEARCH function, 196, 267

SEARCHB function, 196

SECOND function, 193

Security

macros, 817-818

Options dialog, 94-97

Select all shortcut key, 70

Selecting

data and cells, with shortcut 
keys, 69

pictures, 27-28

Selections, extending with 
shortcut keys, 72

Sending workbooks 

as PDFs, 20

as XPS, 20

via e-mail, 20, 1066-1070

via Internet Fax, 20

SERIESSUM function, 186, 505,
539

Shapes, 997, 1015-1018

SharePoint

saving workbooks to a 
SharePoint library, 9

Sharing workbooks 

Excel Web App, 1059-1065

limitations with shared 
workbooks, 866-867

Publish with Interactivity 
option, 1059

SheetName function, 873

Shortcut keys 

borders, 72-76

cells, 72-73

extending selections, 72

legacy versions of Excel, 
69, 76

navigation, 71, 113

selecting data and cells, 69

Windows, 69-70

Show This Number of Recent 
Documents, 97

Showing Ribbon tabs, 62

SIGN function, 191, 228-229

SIN function, 504, 511

Singh, Mala (developer of 
Speedometer Chart Creator 
add-in), 872

SINH function, 504, 517

SKEW function, 390, 443-444

Slash (/) key, 65

Slicer Tools tab (Ribbon), 28

Slicers, 2, 731, 745, 748

SLN function, 345, 360-361

SLOPE function, 390, 424

Slow motion calculation, 162-
163, 861
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SMALL function, 390, 405

SmartArt, 3, 997-999

SmartArt Tools tab (Ribbon), 
29

Social Security numbers, 884

Solver, 791, 807-815

Sorting data 

AZ button (Data tab), 668

blank columns, 676-677

case-sensitive sort, 670

color or icon sort, 669-670

considerations, 667

custom lists, 672-674

entry points for sorting, 668

filtered results, 689-691

fixing sort problems, 675-676

left-to-right sort, 671

legacy versions of Excel, 667

limits, 112

new options in Excel 2010, 
667

one-click sorting, 674-675

pivot tables, 750-752

random sort, 675

Sort dialog, 668

sorting levels, 668

specialized sorting options, 
669

ZA button (Data tab), 668

Sparkline Tools tab (Ribbon), 
29

Sparklines, 2, 983-995

Special states of workbooks 

correcting, 15-16

list of, 14-15

Speedometer Chart Creator 
add-in, 872

Splitting text, 264

SQL Server data, 789

SQL.REQUEST function, 186,
283

SQRT function, 191, 227-228

SQRTPI function, 186, 191, 540

Stacked charts, 959

Standard deviation, 419

Standard toolbar in Excel 2003 
and earlier, 23

STANDARDIZE function, 390,
459

Statistical functions, 165-166,
389-390

Status bar, 39, 52, 99

STDEV.P function, 390, 420-421

STDEV.S function, 390, 420

STDEVA function, 390

STDEVPA function, 390

STEYX function, 390, 439

Stock charts, 974-976

Strikethrough text, 891

Styles, 901-902

Subscript text, 891

SUBSTITUTE function, 196, 270

SUBTOTAL function, 191, 211-
215

Subtotals

adding a blank row after 
each subtotal, 707-709

adding subtotals by two 
fields, 709-710

automatic subtotals, 697-705

summing some columns 
with counting another 
column, 705-707

SUM function, 191, 195-199

SUMIF function, 191, 229-233

SUMIFS function, 165, 178

SUMPRODUCT function, 191,
505, 541

SUMSQ function, 390, 465

SumSQ function, 465-467

SUMX2MY2 function, 390, 465,
466

SUMX2PY2 function, 390, 465,
466

SUMXMY2 function, 390, 465

Superscript text, 891

Surface charts, 972-973

SYD function, 345, 364

Symbols, 861-862

Synchronous scrolling, 860-861

     T  
T function, 196, 275

T-bills, 382

T.DIST function, 390

T.DIST.2T function, 390, 461

T.DIST.RT function, 390

T.INV function, 390

T.INV.2T function, 390

T.TEST function, 390, 461

Table styles, 875

Table Styles gallery, 26

Table Tools tab (Ribbon), 29

Tables

AutoFilter drop-downs, 665-
666

charts, 658-659, 971-972

columns, 651-652

defining, 644-645

expanding, 650-652

formulas, 652-654

headers, 645-646

intelligent tables, 643-644

references, 659-663

resizing, 651

rows, 649-650, 651

selecting only the data in the 
column, 654-658

suitable data, 644

toggling, 649

TAN function, 504, 510
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TANH function, 504, 518

TBILLEQ function, 186, 345,
383

TBILLPRICE function, 186, 345,
383

TBILLYIELD function, 186, 345,
383

TDIST function, 460

Telephone numbers, 884

Templates

charts, 978-979

prebuilt templates, 18-19

Text

bold, 892

converting case, 257

italic, 892

joining, 149, 151, 257

justifying, 916

rotating, 899-900

separating based on a 
delimiter, 867

splitting, 264

strikethrough, 891

subscript, 891

superscript, 891

typeface, 890-891

underline, 892, 891-892

wrapping text in a cell, 915

Text boxes, 997, 1019-1022

TEXT function, 196, 273

Text-to-columns feature, 1086-
1088

Themes, 2, 903-913

Thousands separators, 881

Time

comp time, 99

formats, 233-239

formatting options, 888-889

M:SS and H:MM:SS, 276

negative time, 99

TIME function, 193

TIMEVALUE function, 193

Tip card for Ribbon, 31

TODAY function, 193

Toggling tables, 649

Tools menu in Excel 2003 and 
earlier, 23

ToolTips, 23, 66, 90, 164

Top/bottom rules, 935-936

Transition Navigation Keys 
check box, 65

Translations, 868-869

TRANSPOSE function, 280,
330-331

TREND function, 390, 430

Trendlines, 973-975

Trig functions, 504

TRIM function, 196, 258

TRIMMEAN function, 390, 409

Troubleshooting

formulas, 157-163

keyboard accelerators, 65

TRUE function, 278, 287

TRUNC function, 191, 204

Trust feature, 101

Trusted documents, 16

Trusted locations, 98

Tufte, Edward, 983

Turning on/off interface 
elements, 97-98

TYPE function, 279, 302

Typeface, 890-891

     U  
Underline icon, 892, 891-892

Underline shortcut key, 70

Undo feature, 756

Undo shortcut key, 70

Updates, 21, 22

Updating

default file location, 97

your name, 97

Upgrading from Excel 2003 or 
earlier, 4

UPPER function, 196, 257

Utilities

Able2Extract, 873

ASAP Utilities, 874

commands, 874

CustomizeRibbon, 873

data analysis, 874

developers, 871

DigDB, 874

Easy-XL, 874

J-Walk’s Power Utility Pack, 
874

JMT Utilities, 874

MoreFunc.dll, 873-874

niche industries, 871

number of add-ins available, 
871

PTS Chart Utilities, 871-872

RDBMerge, 874

Speedometer Chart Creator, 
872

XY Chart Labeler, 872

V  
VALUE function, 196, 275

VAR.P function, 390, 420

VAR.S function, 390, 420

VARA function, 390

Variables, 837

VARPA function, 390

VBA (Visual Basic for 
Applications), 756, 817, 831,
836

VBA macros 

automatic trusting of a 
document, 16
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correcting disabled macros 
state, 15-16

customer reports, 849-856

displaying File Open or File 
Save As dialog, 840-842

Easy-XL add-in, 1095

finding the last row with 
data, 842-843

fixing calculation errors, 840

flow control, 845-849

invoice register formatting, 
827-831

learning to use, 817

loops, 843, 844

macro-enabled workbooks, 
97

mail merge, 819-827

object variables, 837

Quick Access Toolbar, 37-38

ranges, 844

recording, 817, 818-819

security, 817-818

variables, 837

VDB function, 345, 364-366

Version compatibility, 118-120

Version of Excel, looking up, 
21

View control, 39, 52-54

View menu in Excel 2003 and 
earlier, 23

View tab (Ribbon), 23

Viewing

file size, 14

Ribbon, 29-30

who made modifications to a 
workbook, 14

Visual Basic for Applications 
(VBA), 756, 817, 831, 836

Visual Display of Quantitative 
Information (Tufte), 954

Visual flyout menus, 25-26

VLOOKUP function, 280, 304,
1080-1085

     W  
Watching the results of a 

distant cell, 858-859

waterfall charts, 871

WEEKDAY function, 193

WEEKNUM function, 186, 193

WEIBULL.DIST function, 390,
475

What-if scenarios, 791-795

Widths of columns, 53

Window menu in Excel 2003 
and earlier, 23

Windows Live account, saving 
workbooks to, 20

Windows Live ID, 17

Windows, resizing, 29-30

WordArt, 997,1018-1019

WordCount function, 873

Workbooks

converting file type, 21

creating, blank workbooks, 
18

creating, from a template, 18

current workbook, getting 
information about, 14

file size, 14

hidden content, finding, 
17-18

Info gallery, 14-15

inserting worksheet in 
middle of, 55

macro-enabled workbooks, 
97

Mark as Final option, 16-17

merging, 874

modications, 14

orientation, 20

path, 14

protected view, 16-17

publishing, Office Web Apps 
option, 1059-1062

recent workbooks, clearing 
the list, 14

recent workbooks, number 
listed, 11

recent workbooks, one-click 
access, 11-13

recent workbooks, scrolling 
to, 11

recovering unsaved 
workbooks, 13

saving, as PDF, 21

saving, as XPS, 21

saving, to SharePoint, 9

saving, to Web, 9

sending, using e-mail, 20

sending, as PDFs, 20

sending, as XPS, 20

sending, via e-mail, 20, 1066-
1069

sending, via Internet Fax, 20

sharing, Excel Web App, 
1059-1065

sharing, limitations of 
sharing, 866-867

sharing, Publish with 
Interactivity option, 1059

special states, correcting, 
15-16

special states, viewing, 14-
15

templates, 18-19

WORKDAY function, 186, 193

WORKDAY.INTL function, 189,
193

WORKDAYS.INTL function, 
165, 179

Worksheet-level scope, 622-623

Worksheets

connecting, two worksheets, 
571, 580
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dragging to a new location, 
54-55

orientation, 20, 1052

paper size, 1052-1053

protecting, 865-866

scaling options, 1053-1054

Wrapping text in a cell, 915

WYSIWYG interaction model 
for commands, 7

 X  
XIRR function, 186, 343, 345,

371-372

XLSM file format, 117

XLSX file format, 116

XML file format, 116

XNPV function, 186, 345, 368-
371

XPS, 20, 21

XY Chart Labeler add-in, 872

 Y  
YEAR function, 193

YEARFRAC function, 186, 193

YEN function, 196

YIELD function, 186, 345, 373-
374

YIELDDISC function, 186, 345,
381-382

YIELDMAT function, 186, 345,
380-382

     Z  
Z.TEST function, 390, 476

Zeroes,displaying as blanks, 98

Zip codes, 884

Zoom slider, 39, 51
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